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I. Introduction 
 
This guide introduces the reader on the usage of the PostiniSync utility created by 
Commercium Technology Inc. (CTI).  Although the document will reference Postini’s 
System Administration web interface, and different LDAP sources, it is not meant to be 
an expert guide for these topics.  Postini provides a System Administration web interface 
for their clients to manage their organization(s) under a hierarchy and it specifically 
covers areas of management not handled by the PostiniSync utility.   
 
The PostiniSync utility was created to help administrators who are responsible for 
managing the Postini users in their organization by synchronizing the email users found 
in their internal directories (LDAP sources) with the Postini user entries found in the 
Postini accounts database.  The management features include: adding; deleting and/or 
suspending; and modifying users appropriately according to organizational policies.   
 
As a prerequisite, the reader should be familiar with:  Postini System Administration web 
interface; your Postini hierarchical organizational structure; have a working knowledge 
on forming LDAP queries; and know the layout of their LDAP source directory. 
 

About EZ Command 
 
EZ Command is Postini’s supported program interface that allows customers to perform 
basic administrative tasks without having to log into the Administration Console.  It 
facilitates the integration of various Postini administrative functions with custom tools 
and applications.  
 
Prerequisites for using EZ Command: 
 
1. The target organization(s) must exist in your company’s Postini organizational 

structure. 
2. The EZ command user will require one or more accounts configured in the 

organization structure with the appropriate Postini administrative privileges. 
3. A "shared secret" value must be entered in the organization’s Postini system 

administration page in order to properly validate authentication strings. The shared 
secret must be set for the organization that the administrative user belongs to.  (The 
shared secret is found under the Generals Settings for the organization.) 
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II. PostiniSync v2 

New Features & Benefits 
 
PostiniSync v2 is the first major update to the automated user management tool.  New 
features were added based on client feedback to make the product even more powerful 
and to support new Java program code changes. 
 
The new features of PostiniSync v2 include the following: 
 

• Support of latest Sun Microsystems’ Java Runtime Environment 5.0 
• Support of multiple Postini organizations within a single job configuration to 

automate user changes based on LDAP changes (adds/deletes/moves) 
• Assignment of non-user accounts to a primary user 
• Lotus Notes SMTP alias account creation 
• More delete behavior options 
• Multiple/combined LDAP search filters per configuration 
• Exception lists supports entire domains and LDAP users by OU/DN values 
• Improved log controls and maintenance 
• More refined deletion protection 

 
Updated features of PostiniSync v2.1 include the following: 
 

• Support for an unlimited number of Postini organizations 
• Support for Groups under Search Info Scope including row prioritization 
• Added scrolling bar for windows with multiple row entries 

Note:  Change in data format of CFG files was necessary to support new features moving 
from v2.0 to v2.1.  See Appendix E for Known Issues if you are upgrading from v2.0. 
 
Unlimited cluster accounts in PostiniSync v2.2 
 
The PostiniSync interface in v2.2 has changed slightly.  Gone is the Cluster Accounts tab.  
Cluster accounts are now setup within the Search Info.  More details on clustering can be 
found in the section on Search Info later on in this document. 
 
When you open up a configuration file from an earlier a version, the Cluster Accounts 
information will be moved to the top of the Search Info tab giving it highest priority.  
You can identify a cluster account because it is separated by a pipe character from the 
Postini organization name in the Organization field. 
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Requirements & Prerequisites  
 
As a Java application, PostiniSync is portable to any platform that supports a Java 
Runtime Environment (JRE).  This document will focus on the installation and usage in a 
Windows environment.  The JRE program must be installed in order to successfully start 
the PostiniSync application.  PostiniSync is a Java application and has been programmed 
and tested successfully with the Sun’s most recent Java Runtime Environment 6.0, 
Standard Edition, also known as Java v1.6.x_xx which is available at Sun's website.   
 
☼ Note:  Due to changes in Sun’s  internal Java code support, PostiniSync2 was 
rewritten to work with the latest JRE distributions.  PostiniSync2 will no longer work 
with the JRE 1.4.x environment which was the supported by PostiniSync v1.x.  
PostiniSync v2 has been tested successfully with JRE v1.6.0_x and JRE v1.5.x . 
 
A job scheduler will be required if automation is desired.  Both, Windows task scheduler 
or crontab (Unix platform) will be sufficient.  The user may use an alternative job 
scheduling program. 
 
The PostiniSync host will be required to execute https commands to Postini’s site.  
Permission for the host must be granted for external communications on https port 443.   
On the internal network, PostiniSync will need access to the LDAP source over its 
designated TCP port number, normally 389.  (A/D global catalog default port is 3268.) 
 
PostiniSync2 requires 1MB of available disk space to install the application and utilizes a 
approximately 64KB of RAM.  Java Runtime Environment 5.0 or greater, Standard 
Edition requires approximately 120MB of available disk space and 17MB of RAM.  It is 
recommended that additional disk space (~100MB) be planned to allow for log and data 
file requirements. 
 

How Does PostiniSync Work? 
 
PostiniSync has two operational modes:  an interactive/configuration interface; and 
command line mode used for scheduled job execution.  The interactive interface is 
designed for testing, job configuration, and running specific one-time job.  Once properly 
configured, it is expected that the user schedules automated jobs to systematically add, 
delete, and/or modify users from the Postini database over the Internet. 
 
The PostiniSync tool will perform an LDAP query based on given search criteria against 
the internal LDAP source.  Different LDAP queries can be saved in configuration files 
and executed automatically via job scheduling software.  The first time that you run the 
tool successfully against your LDAP source, it will create a local database file, whose 
contents will contain a complete export of all email addresses found based on the 
specified search criteria.  This initial synchronization cycle will attempt to add all email 
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addresses to the Postini database.  Any email addresses that are already present will fail 
to be added, but PostiniSync will continue to process new entries. 
 
From this initialization point forward, each successive job will result in a comparison of 
the next query (configname.new) and the previous database file (configname.db) to see 
what has changed in your LDAP source.  Any additions, changes, or deletions are 
processed by PostiniSync issuing the appropriate EZ-command.   
 
 
VERY IMPORTANT: The PostiniSync operator should never delete the local 
PostiniSync database file without understanding the consequences.  When deleted, 
PostiniSync will attempt to add all entries(re-initialization) to the Postini directory on 
the next synchronization cycle.  Any entries that were removed after the previous 
synchronization cycle will not be detected and therefore will not be removed from 
Postini. 
 
 

As per the diagram, PostiniSync is a one-way synchronization tool.  It reads from (never 
writes to) your LDAP directory and assures that the user found in the database are the 
same users found in Postini.  PostiniSync cannot query the user directory on Postini’s end 
due to the limitations of EZ-command.  Any user changes made outside of the 
PostiniSync tool (for instance using the Postini System Administration interface) will not 
be known to the PostiniSync program. 
 

LDAP Query

LDAP
Source

PostiniSync
Host

Postini Web
Host

1

2
3

SMTP Relay

4

5

LDAP Results

HTTPS Upload

Report Sent1. PostiniSync queries LDAP host(s)
2. LDAP results are returned
3. PostiniSync compares new query against last
    query and identifies ADDS/DELETES/MODS
4. PostiniSync pushes up to Postini via https
5. PostiniSync sends results to email addressees

PostiniSync Data Flow Diagram
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Installation 
 
PostiniSync should be installed on a protected system since it will be used in an 
automated production environment.  Java must be installed in order for the applet to run.  
 
If you have not already done so, you need to download the PostiniSync installation 
program from CTI’s website (http://www.postinisync.com).  The installation program is 
named “install.exe” inside the downloaded ZIP file.  The program will include an 
evaluation license key.  You will need to purchase PostiniSync to get a permanent license 
key file.  Please contact CTI if you need a replacement license key file. 
 

To Install PostiniSync 
1. Open the downloaded ZIP file. 
2. Click on “install.exe” and allow the installation program to run. 

 

 
Note:  A security warning may pop up if you have applied recent Microsoft 
patches.  Hit “Run” to continue. 

 
3. The PostiniSync Install pop-up appears and the prompts the user for the 

installation directory.   
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If you are upgrading, you can choose to overwrite the original Version 1.x  or 2.0 
“C:\Program Files\Postini” folder. 
 

4. To accept the specified directory, click on the “Install Now” button. 
 

 
 

5. When the message appears that you have successfully completed installation or 
updated.  Click on the “OK” button. 
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Post-Installation Tasks  
 

Licensing 
 

 
 
If you are evaluating PostiniSync, you may need to request a 30-day evaluation key from 
CTI.  If you have paid for the PostiniSync license, you should have received a non-
expiring license key file (license.txt) for your organization.  This license file should be 
copied to your PostiniSync installation directory.  It is recommended that you save a copy 
of your production license.txt offline marked “read-only.” 
 

Starting PostiniSync 
 
From the Start Menu, select Programs > PostiniSync, click on PostiniSync.  Or add a 
shortcut to your desktop for regular use. 
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PostiniSync is a Java application and a background task screen will appear.  Do not close 
this as it will cause PostiniSync to terminate. 
 

 
The PostiniSync configuration interface will appear in the foreground.
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Menu Bar Actions 
 
The menu bar has three selections:  File; Action; and Help. 

File 
The File category includes New; Open; Save; and Exit. 
 

 

New 
The user selects File > New, to begin the configuration of a new job.  This 
will present completely blank entries in all of tool’s folder values.  The 
user must go through each folder (tab) and specify the appropriate values 
in all entry fields.  

Open  
The user selects File > Open, to open an existing configuration file for 
modification or to Save as another name. 
 

Save  
The user selects File > Save, to save a configuration for a particular 
LDAP search.  In most instances, this query mirrors a particular Postini 
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organization entry.  The user needs to specify a unique file name for this 
particular query and action. 

Exit 
The user selects File > Exit, to leave the PostiniSync interactive and 
configuration interface. 

 

Action 
The Action category allows the user to run, test, purge,or import a configured 
job. 
 

 

Run 
The user selects Action > Run, to execute the currently configured job.  
An activity log will appear displaying the actions that have been executed.   
 

Test 
The user selects Action > Test to test out the current job without 
executing a write to the Postini database.  This is equivalent to the 
“Simulate Load” option that was in Version 1. 
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When prompted to update the database, the administrator should select 
“No” unless they are performing some kind of correction to the production 
DB file, or if they would like to see the results of a test.  It is highly 
recommended that you only update non-production database files until 
you fully understand the PostiniSync workflow. 

Purge 
The user selects Action > Purge to delete users who were suspended in 
Postini.  The administrator will be prompted for a date range of suspended 
users who should be purged. 

Import 
The user selects Action > Import to import a version 1 database or CSV 
file. 
 

Help 
The Help menu contains Contents and About selections.  It will remind you or 
the current version which is useful information for troubleshooting. 
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Contents 
Executing Help > Contents will result in opening up the Help Contents 
dialog box which contains brief instructional documentation with a basic 
explanation for each selection and entry field. 

About 
Executing Help > About will pop-up a dialog box with the version 
number of the PostiniSync tool and the user’s licensing information.  
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III. PostiniSync Configuration Tabs 

Mail Server Info 
 
PostiniSync supports Sun Messaging, Microsoft Exchange 5.5, Active Directory for 
Windows Server 2000 and 2003, Lotus Notes/Domino, Novell Groupwise, or any other 
email system with an LDAP user directory. 
 

 
 
Mail Server – Select the environment type from the drop-down menu.  In the screen 
above, we are selecting an Active Directory used by an Exchange 2003 mail server .  The 
Mail Server Type selection will affect how the entries are processed as each messaging 
environment has unique handling of mail aliases.   
 
Use SSL – Check the box if a SSL connection is required in your environment.   
 
Primary LDAP Host – Enter either the fully-qualified host name that can be resolved by 
DNS, or the IP address of the LDAP directory server.   
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Primary LDAP Port – Enter the LDAP port number that the directory server listens on.  
The standard port number is 389, but it is possible that the LDAP server is configured for 
another port number.  Verify the port number in your LDAP or mail server for the correct 
port number.  The standard LDAP for Active Directory global catalogs is 3268. 
 
Backup LDAP Host – Enter the host of another LDAP directory server to query if the 
Primary is unavailable.   
 
Backup LDAP Port – Enter the TCP port of another LDAP directory server to query if 
the Primary is unavailable. 
 
User DN – Enter the distinguished name of the user account with appropriate access to 
the directory server.  The account needs permission to view the attributes holding the 
SMTP addresses, and have the ability to retrieve an unlimited number of records.  It is 
important that this value is entered using DN syntax, a user ID is not sufficient. 
 
Typical syntax for the LDAP distinguished name in each Mail Server Type: 
Sun uid=mailuser,ou=people,dc=someorg,dc=com 
Lotus Domino CN=Mail User,OU=NJ,o=someorg 
Exchange 5.5 cn=administrator,cn=recipients,o=someorg 
Exchange 200x/Active Directory cn=administrator,cn=users,dc=someorg,dc=com
GroupWise cn=Mail User,cn=NJ,o=someorg 
 
Password – Enter the account password. 
 
Confirm – Enter the password again. 
 
☺Tip:  Try to get authorization for a process account with a non-expiring password. 
 
Mail Attribute – Enter the LDAP attribute which contains the user’s mail address 
(typically “mail”). 
 
Alias Attribute – Enter the LDAP attribute(s) used to store user’s mail aliases (delimit 
multiple attributes with a space).  Typically, they are as follows: 
 

o Exchange 5.5: otherMailbox 
o Active Directory/Exchange 200x:  proxyAddresses 
o SunOne:  mailAlternateAddress 
o Domino:  Aliases cannot be retrieved, but PostiniSync can create them.  Enter the 

attribute from the Domino directory that can be used to create the addressee 
portion of the SMTP address left of the @ character.  You will specify the 
corresponding domain under the Domino Alias option in the Reporting tab. 

o GroupWise:  (GroupWise does not return aliases in LDAP queries)   
 
Once the entries about the Mail Server have been completed, hit the Test LDAP 
Connection button to verify that the settings are correct. 
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Test LDAP Connection Results 
 
The following images were captured from a Windows installation of PostiniSync2 
referencing Active Directory/Exchange 2003 environment: 
 

 
If the Test LDAP Connection is successful, you will see a pop-up as per above. 
 

 
If you enter the wrong User DN, you will see a pop-up as per above indicating invalid 
credentials.  [Error Code 49: data 525] 
 

 
If you enter the wrong User password, you will see a pop-up as per above indicating 
invalid credentials.  [Error Code 49:  data 52e] 
 

 
If you specify an invalid LDAP port, you will see a pop-up as per above with a refused 
connection error. 
 

 
If you specify an invalid LDAP Host entry, you will see a pop-up as per above with a 
timeout connection error. 
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Postini Info 

An Example 
 
For the remainder of this document, suppose we have an organization called Election 
Board which contains the sub-organizations as listed below. 
 

 
 
The users will be the Election candidates who are members of a Group in Active 
Directory.  Any changes that are made in Active Directory will be captured by searches 
created by the Administrator. 
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Postini Host 
At the time of this writing, Postini has 7 sets of host servers.  To find out which host your 
account is being routed to, just login to your Postini System Administration page and 
look at the URL in your web browser.  Or, if you do not know the name of the system 
your organization is hosted on, refer to the following table as a guide: 
 
Postini Name MX Records Include http/URL 
System 5 s5a1.psmtp.com;  s5a2.pstmp.com 

 
ac-s5.postini.com 

System 6 s6a1.psmtp.com;  s6a2.psmtp.com; 
s6b1.psmtp.com;  s6b2.psmtp.com 

ac-s6.postini.com 

System 7 s7a1.psmtp.com;  s7a2.psmtp.com; 
s7b1.psmtp.com;  s7b2.psmtp.com 

ac-s7.postini.com 

System 8 s8a1.psmtp.com;  s8a2.psmtp.com; 
s8b1.psmtp.com;  s8b2.psmtp.com 

ac-s8.postini.com 

System 200 
(Europe) 

s200a1.psmtp.com;  s200a2.psmtp.com; 
s200b1.psmtp.com;  s200b2.psmtp.com 

ac-s200.postini.com

System 201 
(Europe) 

s201a1.psmtp.com;  s201a2.psmtp.com; 
s201b1.psmtp.com;  s201b2.psmtp.com 

ac-s201.postini.com
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The remaining Postini Info criteria must be entered including: 
 
Administrator – Enter the userid of the Postini Administrator for the organization (no 
aliases) 
 
Delete Behavior – select from 6 different deletion options (Delete; Delete - Deactivate; 
Nothing; Suspend; Suspend – Hard; Suspend – Notify; and Suspend – Deliver) from 
the drop-down list.  This defines the behavior of the tool when a user is removed from the 
email server.  Refer to the Postini knowledgebase for more details of each behavior. 
 

 
 

Delete:  will delete the primary user account from the Postini database 
 
Delete - Deactivate:  will deactivate users who can be recovered up to 14 days 
after the deactivation is performed.  After 14 days, the deactivated user is 
permanently deleted. 
 
Nothing:  will do nothing at all to the user account.  It will be up to your 
organization’s Administrator to manually delete the account when required. 
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Suspend:  This will turn filtering off at Postini, the user will still be able to access 
their message center. 
 
Suspend – Hard:  Filtering will be disabled at Postini, and the user will not be 
able to access their message center. 
 
Suspend – Notify:  Filtering will be disabled at Postini, and the user will not be 
able to access their message center, and they will receive a notification email 
about the discontinuation of service. 
 
Suspend – Deliver:  Filtering will be disabled at Postini, and the user will not be 
able to access their message center, and the contents of their message center will 
be delivered. 
 

Welcome Message – select immediate or batch from the drop-down list.  To add the user 
and send a new user a welcome message immediately, select Immediate.  To add the user 
and send a welcome message based on the default organizational setting (which could be 
no notification) or during Postini’s nightly batch process, select Batch. 
 
Shared Secret – enter the shared secret for the organization.  This entry must match the 
value of the Shared Secret set in the Postini System Administration console. 
 
Confirm – re-enter the shared secret for the organization. 
 

Use Proxy Server 
 
PostiniSync includes the option to access the Internet via a proxy server if it is required in 
your environment.  Make the appropriate entries to the Proxy Info section. 
 
If a proxy is not required, then leave “Use Proxy Server” unchecked. 
 
Otherwise, enter the following as necessary: 
 
Proxy Type – select the type of proxy server (currently only http is supported). 
 
Proxy Host – enter the hostname or IP address of the proxy server. 
 
Proxy Port – enter the TCP port that the proxy server listens on. 
 
Proxy User – enter the username for proxy server authentication. 
 
Password – enter the password for the proxy user. 
 
Confirm – re-enter the password for the proxy user. 
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Test Postini Settings – click this button to test the Postini connection settings. 
 

  
If the all entries in the Postini Info folder are valid, a Success dialog will pop-up as the 
result of clicking on Test Postini Settings.   
 

      
An incorrect Shared Secret entry would result in the pop-up shown above.  It will indicate 
“String authentication failed.” 
 

 
An incorrect Postini account entry or selecting the wrong Postini host will result in the 
pop-up shown above.  It will indicate “No such user…” 
 
If you get any other pop-ups; check to make sure that the Postini host is not down by 
trying to log into the web interface.  Also, verify that it isn’t a DNS problem. 
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Search Info 
In the Search Info folder, the user specifies LDAP query information to extract the 
appropriate entries from the directory.  Cluster accounts are now assigned in the Search 
Info tab so that you have the option of prioritizing which query takes precedence for 
users that may appear in more than one LDAP query. 
 

 
The image above shows typical Exchange 2003 Search Info entries.  Click on Test to 
verify that the entries will yield the expected records with the criteria entered. 
 
Scope – Select from either Sub-Tree, One-Level or Group.  Sub-tree will return all 
records beneath the search base that meet the search filter, including that object itself.  
One-Level will return only those entries that are directly beneath the search base.  Group 
will return the entries specified in the search base. 
 
Search Base – The Search Base defines the portion of the LDAP directory to be 
searched.  With Lotus Domino it may be required to leave the search base blank in order 
to see all entries 
 
Postini Organization – Enter the destination organization for entries matching the search 
criteria.  The Postini Organization must be entered exactly as it is at Postini including all 
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spaces.  Alternately, the Postini Organization can contain an LDAP attribute name 
preceded by an ampersand.  (For example:  &ou)  PostiniSync will use the value returned 
as the Postini Organization for each matching entry.   
 
Most organizations have email accounts and distribution lists which expect to receive 
messages from external parties such as “sales@someorg.com” and “info@someorg.com” 
which are managed by an individual or a group.  Rather than get charged for these 
accounts as a Postini primary user account, they can be assigned to an individual or 
another group email address (account ownership).  We refer to these as cluster accounts 
in the tool. 
 
For Cluster Accounts, specify the primary SMTP account separated by the pipe character 
(vertical bar) “|” followed by the Postini Organization where the primary user is found.  
For example, if we want the non-user accounts in the search base to be added as aliases to 
bosco.gong@boscogong.com, you would enter “bosco.gong@boscogong.com|Election 
Board” in the Postini Organization field. 
 

 
  
Up/Down – Allows you to prioritize which search string takes precedence in situations 
where a user’s email account might be found in more than one search.  This is likely to 
happen with a multi-level subtree search.  The first entry found will be the default 
organization for the particular hit.  Cluster accounts are normally found at the very top. 
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☼ Note:  The Alternate Search String from Version 1 has been eliminated.  The 
Administrator may enter more than one search string per named organization which is 
the equivalent of the alternate search string. 
 
Filter – Enter an LDAP compliant search filter in this field.  Most often it will be in a 
form such as (objectclass=person) or (&(objectclass=person)(inetuserstatus=active)).  
Common filter entries include the following: 
 

o Exchange 5.5:  (objectclass=organizationalperson) 
o Active Directory for Exchange 200x: (objectclass=user) 
o SunOne: (objectclass=inetmailuser) 
o GroupWise:  (objectclass=person) 
o Domino:  (objectclass=person) 

 
☼ Note:  For more information on LDAP Filters see Appendix A. 
 

 
A successful test with correct search settings is shown in the image above.  The pop-up 
will return only first 10 records of a successful query for test purposes. 
 

 
This Warning dialog box will pop-up if no results are returned. 
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The above warning will appear if an incorrect Search Filter is specified. 
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Exception List 
 
The Exception List should include all email addresses, domains, and other OU or DN 
LDAP entires that should not be modified (add/delete/change) by the PostiniSync tool.  
Besides the administrator account, you may want to include process accounts from the 
LDAP query that could not be filtered out.  Each account must be entered on a separate 
line.  SMTP addresses that are not going to be receiving email from outside should be 
included here. 
 

 
Above, we have a non-user internal email accounts along with any SMTP addresses with 
postinisync.com domain entered in our Exception List.  These Postini accounts will not 
be modified by any changes picked up by the PostiniSync tool.  If you do not want to be 
charged by Postini for a non-user account, make the non-user email entry into the 
Exception List before the initial run, so that they are not added to the list of Postini users. 
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Reporting/Miscellaneous 
 

 

Reporting 
 
The reporting function will email the results of each job execution to the designated 
recipient(s).  This automatic mailing function applies only to command-line execution 
when used in the Task Scheduler.  Reporting is not enabled for GUI mode. 
 
SMTP Relay Host – Enter the hostname or IP address of an SMTP host that can relay 
the report to the internal recipients. 
 
Email Address(es) – Enter the email address(es) for users, groups, pagers, etc…, to send 
the results to.  (The addresses should be separated by a space character.) 
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Log Settings 
 
Version 2 now includes log maintenance.  The administrator can set the log history 
information. 
 
Maximum Age for Logs – Enter the number of days which the logs should be kept 
before being automatically deleted.  The log files have the following the naming 
structure:  configname_yyyymmdd.log, which are found in the PostiniSync installation 
directory. 
 
Maximum Disk Space for Logs – Some organizations will be generating large log files 
and the administrator may want to limit the disk space which they will take up.  Set the 
allowable disk space in MB. 
 
Logging Level – The administrator has a choice of normal or verbose.  Normal logging 
retains basic command level logging, and verbose logging includes the creation details of 
the local db files. 
 

Delete Protection 
 
Delete protection is provided to prevent the catastrophic scenario of accidentally deleting 
all of your users from the Postini system.  This could occur for any number of reasons 
and this may include:  failed or incomplete LDAP query due to a network failure; 
directory server sabotage; accidental deletion of LDAP entries; or some other unforeseen 
predicament.  Use the up and down arrows to change the percentage threshold value. 
 
Abort If Deletes Exceed – If the percentage of deletions exceed the designated 
percentage, the job will not do any deletions at all.  However, the administrator has an 
option to allow the job to continue to perform the Adds and Modifies. 
 
☼ Note:  Version 2 no longer supports the discrete Number of Users count for the 
threshold value as in Version 1.  Use the up and down arrows to change the threshold. 
 
Continue adds and modifies – When checked, the job will continue to perform Adds 
and Modifies even if the deletion percentage threshold is exceeded.  If left uncheck, the 
synchronization job will terminate.  If the threshold is exceeded, the users who were 
meant to be deleted will be added to a control queue for later deletion if the Administrator 
increases the threshold value to continue with the deletions upon the next job execution.   
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The Activity Log above shows that the tool terminated because the threshold value had 
been exceeded.  We had deleted 3 users in the DB file which is 9 percent exceeding the 
threshold value was 5 percent.  

Domino Aliases 
 
For Lotus Domino users, PostiniSync 2 now allows for the creation of mail aliases.   
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Domain(s) – Enter the mail domains for the Domino environment for which you want to 
create aliases. 
 
Separator – Select from the pull-down list, the type of formed alias(es). 
 
The user should specify the attribute used for creating the SMTP username in Alias 
Attribute input field under Mail Server Info tab.  Suppose for our example cn is specified 
with the separators “_ and .” are selected:  The aliases: joe_bloggs@aliasdomain.com, 
joe.bloggs@aliasdomain.com, joe_bloggs@supernova.com, and 
joe.bloggs@supernova.com would be created for the user with cn=Joe Bloggs.  
 

 
Indicate the directory attribute that will be used for form the user side of the SMTP alias.  
Here we will use cn (common name) attribute. 
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Appendix A – Understanding LDAP Filters 

Operators 

The following table lists frequently used search filter operators.  

Operator Description 
= Equal to 

~= Approximately equal to 
<= Lexicographically less than or equal to 
>= Lexicographically greater than or equal to 
& AND 
| OR 
! NOT 

 

Examples  
 
The following filter will return all objects. 
 
(objectclass=*) 
 
The following filter will return all users in the Exchange 2000 that have a userid that 
starts with “U” 
 
(&(objectclass=user)(samaccountname=U*)) 
 
The following filter will return all objects with the last name of Jones or Jackson 
 
(&(objectclass=person)(|(sn=Jones)(sn=Jackson))) 
 
The following Exchange 2000 filter will exclude all users that are hidden from the 
address book or disabled. 
 
(&(objectclass=user)(!(msexchhidefromaddresslists=TRUE))(msexchuserAccountcontrol=0)) 
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More A.D. Examples 
 
Search For LDAP Query Syntax 
Global address list (&(|(mail=*)(proxyAddresses=*)(textEncodedORAddress=*)) 

(|(objectCategory=person)(objectCategory=group) 
(objectCategory=publicFolder))) 

All Users (&(|(mail=*)(proxyAddresses=*)(textEncodedORAddress=*)) 
(|(&(objectCategory=person)(objectClass=user)))) 

All Groups (&(|(mail=*)(proxyAddresses=*)(textEncodedORAddress=*)) 
(|(objectCategory=group))) 

All Contacts (&(|(mail=*)(proxyAddresses=*)(textEncodedORAddress=*)) 
(|(&(objectCategory=person)(objectClass=contact)))) 

 
Public Folders (&(|(mail=*)(proxyAddresses=*)(textEncodedORAddress=*)) 

(|(objectCategory=publicFolder))) 
 

Domino Examples 
 
Search For LDAP Query Syntax 
Domino Groups (objectclass=dominoGroup) 
MailIn Databases (objectclass=dominoServerMailInDatabase) 
Domino Users (objectclass=person) 
 
For more information and examples refer to RFC 2254 “The String Representation of 
LDAP Search Filters”   http://rfc.net/rfc2254.html 
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Appendix B – Understanding the Local Database 
 
After every synchronization cycle, the local database is updated.  This database will be 
found in the install directory (typically C:\Program Files\PostiniSync) and will have the 
same name as the file used to save the configuration settings. (For Example: 
configname.cfg will have an associated configname.db.) 
 
This database is a simple, flat text file, delimited with a pipe “|”, and has the following 
fields/columns 
 
Column 1 – The distinguished name of the entry. 
Column 2 – The primary email address of the entry. 
Column 3 – Entry status (Active, Deleted Suspended). 
Column 4 – Modify Date. 
Column 5 – Creation Date. 
Column 6 – Postini Organization. 
Column 7+ – Aliases 
 

 
This data can be easily imported into Microsoft Excel or another spreadsheet for 
inspection and analysis. 
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Appendix C - Job Scheduling 
 
PostiniSync can be run interactively or scheduled as an automated job.  The interactive 
session was described in the previous section.  Interactive sessions are best for testing 
jobs before being scheduled regularly.  The administrator can use Microsoft’s Task 
Scheduler to schedule jobs, or a third-party job scheduling utility.   
 

 
 
The entry in the Task Scheduler > Run should follow the PostiniSync command line 
options.  Specify the job configuration file that will be executed at the scheduled time.  
(In the above example, the configuration “dummycorp.cfg” will be run at Noon each day.)   
 
The correct syntax in Task Scheduler > Task > Run is: 
 
“%PostiniSync Installation Directory%\ps.exe”  configurationname.cfg 
 
Replacing the %PostiniSync Installation Directory% with the proper value. 
 
The administrator will schedule as many job runs as required for the particular 
(sub-)organization.  Hint:  The name of the configuration file should match your 
organization name for easy reference in the future.  
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Appendix D – Moving from v2.1 to v2.2 
 
When upgrading from v2.1 to v2.2, the old configuration files will need to be saved again 
in v2.2 format.  A dialog pop-up box warning about file compatilibility will appear the 
first time you open a CFG file saved in the previous version.  By default, the Cluster 
Account entries from v2.1 will appear at the top of the list for Search Info.  However, the 
data files are compatible.  After the migration, PostiniSync will continue to manage the 
existing user database without an issue. 
 

 
After upgrading to v2.2, if you attempt to open a v2.1 job configuration file, you will get 
a pop-up warning that looks like the next figure. 
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Appendix E – Migrating to PostiniSync 
 
If your organization is already using Postini in production and you are now considering 
using PostiniSync to automate the management of users, the reader should follow the 
instructions in this section.   
 
As discussed in the “How Does PostiniSync Work” section at the beginning of this 
document, PostiniSync compares the current LDAP query results against the last results 
to identify the required changes.  If an organization is already in production with users 
previously added through alternative methods, it becomes necessary to establish a 
baseline of current accounts from the Postini database.  Failure to do so will result in user 
that are in Postini, but not in their LDAP source.  This process will also save time when 
the first synchronization cycle is run since it does not have to fail on users it tries to add 
again in the initialization process.  This will serve as the last run job also known as the 
configname.db file which is compared against the configname.new file.  
 
☼ Note:  If there is an SMTP alias address in Postini that is not listed in your current 
LDAP directory, the alias will become stranded in Postini.  This is the same reason that 
existing users need to be imported into PostiniSync. 
 

Exporting Users From Postini 
 

 
 

1. Login to Postini as an Administrator 

2. Click on the Orgs and Users tab. 

3. Select the organization that you need to export from (i.e. >StatePolice). 
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4. Click on the Users Link. 

5. Click on the Download Users/Settings Link. 

 
6. When the pop-up window appears, highlight all of the data, right-click and select 

Copy.  Close the pop-up window. 

7. Open Notepad or another text editor. 

8. Right-click in the editor and select Paste. 

9. Save the file as <Organization>.csv. 

10. Repeat the steps for other organizations as necessary. 

Importing Users Into PostiniSync (Establishing a Baseline) 
☼ Note:  The procedure outlined here is for new PostiniSync users who need to establish 
a baseline for their initial PostiniSync synchronization. 
 

1. Start PostiniSync. 

2. Click on Action > Import. 

3. Select the CSV file to be imported and click on the Open button. 
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4. Enter the Postini organization that you want to establish the baseline for, and 
select Append to Database (if you need to build a database from multiple CSVs).  
Click on the OK button to complete the import. 

 

5. Repeat the procedure for any other organizations. 
 

 
 
6. Test this new baseline against a new LDAP query to confirm that the 

adds/deletes/moves correspond with what you expect.  Select Action > Test, and 
verify the results. 

 

 
 
7. If the export and import procedures worked well, then you are ready to proceed 

with an initial production run.  Erase all corresponding configname.db and 
configname.new files, if this is a first time baseline and initial run.  Repeat the 
procedures starting from Step 2 through Step 5. 

 
☼ Note:  Make sure that you understand the ramifications of deleting files. 
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8. This time, select Action > Run, and PostiniSync will make the required changes 

to update the accounts in your Postini organization. 
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Appendix F – Contacting Technical Support 
 
To contact CTI Technical Support for help with PostiniSync, use any of the following: 
 
Email:  Support@CTIcorp.com 
Telephone:  1-800-579-1902 (Ext. 3) 
 
Home Page:  http://www.CTIcorp.com 
 
 


